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1 Introduction
Welcome to the GUITAR RIG 4 Application Reference!

1.1 About this Manual

This manual covers all elements of GUITAR RIG 4 in detail. If you want to get deeply into
the software, this is the document to refer to.
The following documents are also available:
= The Setup Guide tells you how to install, activate and configure GUITAR RIG 4 on
your system.
= The Getting Started guide provides you with essential information needed to use GUI-
TAR RIG 4 and explains how to accomplish fundamental tasks.
= To learn about each and every knob that controls the amps, distortion pedals and oth-
er components for shaping and modulating GUITAR RIG's sounds, refer to the Com-
ponents Reference.
= If you have obtained GUITAR RIG 4 in a hardware bundle (MOBILE/SESSION/KON-
TROL), please read the according Hardware Reference to correctly set up your hard-
ware and software.
All the manuals can be accessed through the program menu by selecting Help > Open
Manual.
Visit the community forums at http://www.native-instruments.com/forum, where beginners
and experienced users exchange knowledge on Native Instruments products every day.

Safety Considerations

GUITAR RIG 4—in combination with headphones or amplifier-driven speakers—can pro-
duce volumes that may cause hearing damages. For your protection, set all volume levels
to a minimum before using GUITAR RIG 4. Gradually raise the volume controls while mu-
sic is playing to set the desired listening level. If you experience any hearing problems or
persistent ringing in the ears, consult an audiologist immediately.

Introduction
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User Interface

2 User Interface

Learn everything about the GUITAR RIG 4 user interface in the following sections.
& GuitarRig
( Components ®) Options

MASTER  PRE-AMP BASS

ame Rating

049 Andy in a bottle - CF
Billy Dual Grange

052 Lotta Love - MC

053 Break my Heart - MC

054 limi's Hot UniNine

055 Fire MC a9 e B B By AN

056 Hot Clean =
st < Pat Lead Preset Prev Preset Next MEI:F;r;nma REKKickDown
Country Tweed
Pete won't explain
Surfing L L

061 Tremolo Twang RK Switch 3 RK Switch 4 RK Pedal

Info

Fig. 2-1 The user interface of GUITAR RIG in Standard View
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User Interface
Global Header

2.1 Global Header

The Global Header (visible both in Standard view and in Live view) assembles the main
input and output controls as well as the system performance display of GUITAR RIG 4.

Fig. 2-2 GUITAR RIG Global Header

Apart from these, the Live button is situated in the Global Header. It activates Live view,
which has been optimized for on-stage use—see section 12.2, Live View for more informa-
tion.

2.1.1  Input and Output

From left to right, the following global input and output controls are available:

» The /R buttons control the input routing of the software. By default, both input chan-
nels are processed. If one channel is deactivated by clicking on its button, the other’s
(mono) signal will be routed to both of GUITAR RIG’s stereo channels. This is recom-
mended if you are processing a single guitar or bass.

= The Input Meter (IN) shows the amplitude of the incoming signal and features an inte-
grated volume fader that controls the input level of the software. It should be adjust-
ed so that the Input Meter gets close to, but never hits the red zone, which is indicat-
ing overload.

= The Gate button operates a basic noise Gate, killing hiss when you are not playing.
Turn it on and off by clicking on the button, adjust the threshold to your actual resid-
ual noise level with the knob right of it. When double-clicking the threshold knob, a
learn function to automatically set the optimum threshold is it activated. Do not play
your instrument for some seconds: GUITAR RIG 4 analyzes your signal and sets the
threshold just above any residual noise.

= The Output Meter (OUT) shows the amplitude of the software’s output and features an in-
tegrated volume fader that controls the output level. It should be adjusted so that the
limiter is never triggered, indicated by the Output Meter hitting the orange zone.

GUITAR RIG 4 - Application Reference - 9



User Interface
Global Header

= The Limiter is preventing the output level from reaching overdriven and possibly harm-
ful volume peaks. You can turn it off by clicking on the button anytime, overdrive will
then be indicated by red LEDs.

2.1.2  System Performance

The right-most section shows information about your system’s performance:

= Your CPU load is constantly measured—it should not go above 70% to avoid clicks and
interruptions.

= |f it is necessary to save some CPU power without limiting the number of compo-
nents, you can deactivate High Quality Mode by clicking on the HI button. High Quali-
ty Mode means that the current sample rate is doubled using oversampling, resulting
in a higher resolution of sound.

= Clicking on the Power button completely bypasses the sound processing of GUI-
TAR RIG 4, changing the CPU display to BYP.

= When no audio driver is selected, the CPU display shows OFF.

= |f a CPU overload occurs, the display shows OVER and the Power button turns red—the
audio engine has been disabled. You might need to disable some components or turn
off high quality mode to save CPU power. Then re-activate the audio engine by click-
ing the Power button.

GUITAR RIG 4 - Application Reference - 10
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2.2 Live View

& GuitarRig

R MIx 009 Early Edward (HB)
004 Geod's Love

005 Black Malcolm Rhythm (HB)

006 Black Angus Lead (HB)

007 Black Sun Garden

008 Billy Dual Grange

010 Surfing

011 One May

012 Dual Riff

013 Arpeggio Delays METRONOME

Guitar panned to the left with reverb panned to the right.

Preset Prev Preset Next Metronome RK KickDown
Tap

L] ] ]

RK Switch 2 verb Octaverb RK Pedal
On/Off

Fig. 2-3 GUITAR RIG Live View

Clicking on the Live button in the Global Header or pressing F1 switches from the Standard
view to the Live view. It hides the Rack and instead puts the most important performance
features into a clear layout.
The Live view is perfect for on-stage use, consolidating the following elements:

= Global Header

GUITAR RIG 4 - Application Reference - 11



User Interface
Toolbar and Rack

= Current Preset List as defined in the Preset Browser

= Currently selected preset with information

= Metronome, Tuner, and Loop Machine (optional)

= Large Virtual Rig Kontrol display with all assighments
Metronome, Tuner and Loop Machine
You can activate these Live view options by clicking on the buttons labeled Metronome, Tuner
and Loop Machine. Whenever your trigger the Tuner via controller inputs, the corresponding
view will automatically be activated.

2.3  Toolbar and Rack

If you are in Live view, please return to Standard view by clicking on the Live button to con-
tinue our tour through the user interface of GUITAR RIG 4.
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Toolbar and Rack

PRE

PLAY
AT INFUT
AT QUTPUT

[DIEIEIJ 1-] rm[g‘zlnlom’]_

TUNER wmute ()

CENTS TUNE TUNE FORK

|

|

' |

- |
7 +7 !

#1  hiclave.wav

PRESET VOLUME

MASTER

—_—

Preset Prev Preset Next Metronome RKKickDown
ap

L L~ 2 L

RK Switch 1 RK Switch 2 RK Switch 3 RK Switch 4 RK Pedal

Fig. 2-4 The Rack with Tools and Virtual Rig Kontrol

The Toolbar sits on top of the Rack and is your one-stop-shop for all the Rack Tools and
some other frequently used features.
= The left-most box shows the currently activated preset. You can step through the cur-
rent Preset List by clicking on the Up/Down arrows, even if it is not visible.
= Save makes changes to the loaded preset permanent, overriding the stored settings
with the current ones. Don’t press this button unless you are sure about the changes
you've made!
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User Interface
Virtual Rig Kontrol

= Save as creates a new preset with the current settings. After clicking Save as, you are
presented with the Save As page in the SideKick, where you can enter a name, au-
thor, rating and notes to save with the preset. It will be saved with all tags which are
currently selected in the upper part of the Preset Browser, unless you change them
before you press Save to confirm.
= The middle buttons toggle the display of the Virtual Rig Kontrol (see section 12.4, Vir-
tual Rig Kontrol) and all the Rack Tools: Tapedeck Pre (for playing back), Tapedeck
Post (for recording), Tuner and Metronome (for synchronizing effects and yourself),
PRST (Preset Volume) and MSTR FX (Master FX) See section 15, The Rack Tools for
details on the Rack Tools.
= On the right side, the x (cross) will empty the rack of all components with one click —
this can of course be undone by selecting Edit > Undo from the program menu or by
pressing CTRL+Z (Win) / CMD+Z (Mac).
= Clicking on the - (minus) minimizes all rack modules. It then turns into a + (plus),
allowing to restore the previous view.
The Rack itself holds all components that are processing your sound—giving a clear over-
view of the signal flow. It is the heart of GUITAR RIG 4’s functionality, and incredibly easy
to use with drag and drop. See section 14, Components and the Rack for all details.

2.4  Virtual Rig Kontrol

The Virtual Rig Kontrol is shown after clicking on its button in the Toolbar or pressing F3.
It is a graphical representation of the Rig Kontrol foot controller, indicating which func-
tions are assigned to its buttons and the foot pedal. See section 16, The Rig Kontrol for an
exhaustive explanation.
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SideKick

L 9 —

Preset Prav Metronome REKickDown
Tap

~ ~ L

RK Switch 1 RK Switch 2 RK Switch 3 RK Switch 4

Fig. 2-5 Virtual Rig Kontrol

The buttons and the foot pedal can also be operated directly with the mouse, if no Rig
Kontrol is connected. Even if you are not using the Rig Kontrol, you can assign external
MIDI controllers to the Virtual Rig Kontrol to benefit from its integration, especially in Live
view. See section 18.1.3, Linking External MIDI Controllers to the Virtual Rig Kontrol for
details.

2.5  SideKick

About a third of the user interface is occupied by the SideKick, a multi-functional area on
the left hand side of the screen.
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4

002 Foo Monkey Ultra

003 Andy in a battle

004 God's Love

005 Black Malcolm Rhythm (HB)
006 Black Angus Lead (HB)
007 Black Sun Garden

008 Billy Dual Grange

009 Early Edward (HB)
010 Surfing

011 One May

012 Dual Riff

013 Arpeggio Delays
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Fig. 2-6 The Sidekick in three different modes

User Interface
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It displays different content, depending on which of the tab buttons (Browser, Components or
Options) is activated. The SideKick is not necessary all the time and can be hidden by
clicking on the Arrow button situated next to the tab buttons, or by pressing F2.
= The Preset Browser [1] allows filtering of all available Rack Presets on three levels;
you can organize your presets and perform a text search to easily find your presets.
See section 13, Working with Presets on working with presets.
= The Component Pool [2] contains all available components along with their presets,
ready for dragging them into the Rack. Their complete explanations can be found in
the Components Reference, but you will find out most of it by just trying them out.
See section 14, Components and the Rack on building up your rack.
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SideKick

= The Options screen [3] serves to configure external controllers and their assignments,
as well as preferences such as the window height, the path to presets and other de-
tails. See section 18, Options on setting up MIDI controllers and all the options.
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Working with Presets

3 Working with Presets

GUITAR RIG 4 would only be half as useful without a sophisticated management system
to help you find and organize all available presets. A completely reworked, tag-based Pre-
set Browser and a powerful search function make navigating through presets and manag-
ing them a joy, and Component Presets allow for a convenient modular approach to rack
building.

At this point, it is important to understand that there are two different kinds of presets in
GUITAR RIG 4:

Rack Presets
Rack Presets allow you to store and recall complete Rack setups and organize them in a
convenient way using the Preset Browser. Each Rack Preset consists of a chain of compo-
nents with their exact configuration that is loaded into the Rack when the preset is activat-
ed. At the same time, it preserves the tempo and all controller assignments.
The latter can be overridden when the preset is loaded. This depends on the following set-
tings:
= The Metronome’s Sync control is set to Ext or Free: This prevents the Metronome’s tem-
po to change when loading a preset. Set it to Sound if you want the tempo setting to be
loaded with the Rack Preset.
= The assignments of the Virtual Rig Kontrol and other controllers can be globally
locked (see section 16.2, Assigning Functions to the Rig Kontrol and 18.1.2, Assign-
ing Functions to Controllers), which is indicated by a small padlock symbol. These
will not be affected by controller assighments stored in a Rack Preset.
GUITAR RIG 4 ships with a huge amount of Rack Presets of any style, and you can easily
create more as you see fit.

Component Presets

A Component Preset contains all settings for one single component, such as the exact
knob positions of an amp producing your favourite crunch tone. After highlighting one of
the items in the Component Pool, all its available presets are shown in a list below. Use

GUITAR RIG 4 - Application Reference - 18



Working with Presets
The Preset Browser

Component Presets to store and recall your favorite delay setting or try a special amp
sound in another rack’s context. As Component Presets are a tool for building your Rack,

you find all details in section 14.2, Component Presets.

3.1 The Preset Browser

p Browser (@ Components (® Options

# Presetname ~ Rating

001 no namez2

002 Brian's Vision1

003 Brit Pop Rhythm (SC Bridge)1

004 Ch Crunch (SC+ HB Bridge)1
005 C AC Box (SC+ HB)

006 CrunchyLP (HB Bridge)1

007 Fat Clean AC (SC +HB)1

008 Hot Treble Boost (HB Bridge)1
009 Hot Treble Boost (SC Bridge)1

Fig. 3-1 The Preset Browser
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Working with Presets
The Preset Browser

Click on the Browser button to open the Preset Browser —a powerful tool for finding and
organizing all your Rack Presets.

3.1.1  Tags and the Preset List

Three columns with several tags, entitled Preset Attributes, define which presets are
shown in the Preset List below. You can select and deselect tags by clicking on them
once. If no tag is highlighted (orange), all available presets are shown.
= Click on a tag in the left column to select it: The Preset List is instantly reduced to
the presets containing this tag.
= |f the tag you chose contains sub-tags, they can be selected in the middle column.
= Sub-tags of the third level appear in the right column, if present.
= Consequently, sub-tags disappear if you deselect the tag they belong to by clicking on
it.
= You can select multiple tags by holding SHIFT or CTRL while you click.
The Preset List itself sports 3 columns: List Number (#), Name and Rating. Note that you
can resize the height of the list by dragging the resize handle just below the search bar.
Clicking on the column headers will sort by the according values, first ascending then de-
scending.
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The Preset Browser

Presetname Rating

Brian's Vision

Hot Treble Boost (SC Bridge)
2U is no name

Clean AC Box (SC + HBE)

Crunchy LP H Bridge)

Fat Clean AC (SC + HB)

Chrystal Crunch (SC + HB Bridge)

Hot Treble Boost (HE Bridge)

Fig. 3-2 Preset List and Ratings

The Rating system is very helpful for keeping order in your growing archive: Give your pre-
sets a quality rating from 1-5 stars by clicking on one of the 5 dots right beside its name.
It will instantly be stored with the preset, to help your memory and—after doing this with
all your presets—provide you with a powerful Preset List: Sort it by rating!

3.1.2  The Search Engine

The new search engine will help you to quickly find a particular preset by entering part of
its name. The search bar is situated below the Preset Browser and always ready to process
your requests.
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001
002
003
004
005
006
007
008
009
010

Presetnarme +* Rating

Heavy Lead (HB Bridge)

Heavy Pickin

Heavy Sonic (HB Bridge)

LEAD 800 Delay+Heavy 5trat
LEAD 2800 Dropped+Heavy Strat
LEAD 800+Heavy S5trat-1

LEAD B00+Heavy Strat-2

5lap Bass heavy distorted

Slap Bass heavy distorted

Slap Bass heavy distorted?2

Fig. 3-3 Preset Search

Working with Presets
The Preset Browser

It works incrementally: With every letter you type in, it will narrow down the Preset List
below by only showing presets that contain the string you entered. Clicking on the x (Cross)
clears the search bar.

3.1.3

Loading and Saving Rack Presets

Loading Rack Presets works plain simple from the Preset List: Just double-click on the
name of the preset you want to load. If you press ALT while doing so, all the components’
Stereo buttons will be engaged regardless of their stored settings—so your complete Rack
will be processing audio in true stereo.
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The Preset Browser

Any changes you make now won't automatically be saved to the preset. If you want them
to be permanent, click on Save on the bottom of the SideKick.

3.1.4  Importing Presets

There are two ways of importing presets into GUITAR RIG 4—depending on the use case
either of them can be the most convenient way to go:
= When you drag and drop preset files into the Preset Browser, they will be copied to
the preset folder of GUITAR RIG 4 and get the tag(s) that were selected before.
= After you select File > Import from the GUITAR RIG 4 menu, you can select presets
to be copied to the preset folder and imported with all the tags they already had. The
same happens when you copy files to the preset folder manually and click on Scan Pre-
sets on the Options / Preferences page.

3.1.5  Exporting Presets

Aside from simply copying preset files directly from the preset directory, there’s a conven-

ient way of exporting presets directly from the Preset Browser:

1. Make sure the presets you want to export are visible in the Preset List by selecting the
right tags in the Browser.

2. Select them by clicking while holding the CTRL (Win) or CMD (Mac) key, pressing

CTRL / CMD + A selects all presets in the list. Selecting all the presets in the list

which are currently not selected is possible by pressing CTRL / CMD + | (invert).

Copy the presets to the clipboard, i.e. by pressing CTRL / CMD + C.

4. Paste them anywhere in the Windows Explorer or Finder, simply by selecting the des-
tination folder and pressing CTRL / CMD + V, and you're done!

w

3.1.6  Saving New Rack Presets

If you want to save your current rack to a new preset, click on Save as.... You are now pre-
sented with a special page in the SideKick, where you can enter the preset's name, au-
thor, rating and some notes to save with it.
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The Preset Browser

p Browser (* Components (®) Options

t Attributes

GR4 Mix Ultrasonic _
Bass Amps Hot Plex
Lead 800

Effects Jump

Tweed Delight
Twang Reverb

Jazz Amp

Sound Name New Pre: Ectl

Tue Jun 12

Fig. 3-4 Saving new presets

The preset will be saved with all tags which are currently selected in the upper part of the
Preset Browser. You can still change them on the Save As page, before you press Save again
to confirm. To delete a preset, right-click on it in the Preset List and select Remove from
disk.
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The Preset Browser

3.1.7  Tags on Three Levels

The tags under Preset Attributes are hierarchic, getting more precise from left to right.
Each tag of the first and second level can contain sub-tags that further narrow down what
you are looking for.

Creating and Deleting Tags
You can create and relate tags to organize your presets exactly as you want. As each preset
can appear under multiple tags of different levels, you have a lot of organizational power at
hand. Use tags to characterize and group your sounds on up to three levels: To order them
by musical genres or pickup types, or to create set-lists for live use.
= Tags can be created by double-clicking into an empty field or by right-clicking into a
column and selecting Create a new tag.
= Tags in the second and third column can be created only if a tag is selected left of
them—they are sub-tags to the ones on the higher level!

Preset Attributes

Stacks

Styles

Instruments
Effects

Fig. 3-5 Creating a Tag

= To delete a tag, click on it so that it is highlighted in orange (selected). Then right-
click anywhere in the Preset Browser. Select Delete this tag to delete the selected tag
and all of its sub-tags.

= No preset will be harmed by deleting a tag—all presets are still in the Preset List
when no tag is selected. To delete a preset, right-click on it in the Preset List and se-
lect Remove from disk.

GUITAR RIG 4 - Application Reference - 25



Working with Presets
The Preset Browser

Example

= Let us create an exemplary three-level tag which you could add to all the presets you
are currently preparing to use on stage with your band: “Your Band—Live-Presets—In
Progress.“

= Create a new tag simply by double-clicking on an empty field in the first column.
Type in a text label (e.g. your bandname) and press ENTER.

= Click on the newly created tag to select it—it must be highlighted in orange. Double-
click into the middle column and create a new tag (e.g. “Live-Presets”). This is your
first sub-tag; another useful one could be “Studio-Presets.”

= Sub-tags are only visible in relation to their higher-level tags. If you deselect “Your
Band” on the first level by clicking on it again, all of its sub-tags disappear.

= Creating a sub-tag on the third level works exactly the same way, just highlight “Live-
Presets” and create a new tag called “In Progress” in the right-most column.

3.1.8  Tagging Presets
Any preset can carry an unlimited number of tags! Adding tags to presets works simply
with drag and drop:
= Click on one of the presets in the Preset List and drag it onto one of the tags in the
left column of the Preset Browser.
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The Preset Browser

Heroes trasomc

Styles

Instruments
Effects
My Presets

Fig. 3-6 Tagging Presets

= While dragging and holding down the mouse button, you can navigate through sub-
tags to further specify the precise tag you want to add. The moment you release the
mouse button to drop the preset on a tag (no matter on which level), the tag is added
to the preset.

= Because of the hierarchical structure of the tagging system, adding a sub-tag auto-
matically adds its higher-level tag(s) to the preset.

= Drag and drop adds new tags to the preset without deleting the previous ones: The
preset will be listed both under the tag that was activated before you dragged it, and
under the new tag.

= To remove the currently selected tag from a preset, just delete the entry from the Pre-
set List below. Make sure the correct tag (with sub-tags) is selected, click on the pre-
set in the Preset List, and press DEL (Win) / CMD+BACKSPACE (Mac). Or right-click
and select Remove from this list.

= An easy way to remove a preset from many Preset Lists is to use the Info Page (see
section 13.2, Preset Info Page).
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Working with Presets
Preset Info Page

= After removing all tags from a preset, it is still available in the Preset Browser when
you de-select all tags.
= To really delete a preset, highlight it, right-click and select Remove from disk.

3.2  Preset Info Page

After clicking on Info, the following information is shown for the currently selected preset.

(® Components (8) Options

LEAD 800+Heavy Strat-1

Author Godi Hildmann £ Patrick Arp
Rating

MNotes

Preset Attributes
GR3
GR3 > My Sounds

GR3 > My Sounds > Godi GO

Fig. 3-7 Preset Attributes

All the fields can be edited after clicking into the field beneath the label once.
= Author: The last name you entered in the Save as... dialogue will be used as default.
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Preset Info Page

Rating: Click on the dots / stars to change the rating.

Notes: These will be shown in Live view—a good place for your cheat slip!

Preset Attributes: This shows all tags stored with the currently selected preset at a
glance. After selecting one of the tags, the Preset List will change showing all the pre-
sets containing this tag. Deleting a preset from the Preset List will remove the cur-
rently selected tag from it.
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4 Components and the Rack

4.1  Building a Rack from Scratch

On the first start, the Rack of GUITAR RIG 4 is empty, you will hear dry, slightly pre-am-

plified guitar sound when you play: an invitation to try out the various components all by
yourself.
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Fig. 4-1 The empty Rack

On future starts, the software will always retain the last state of the Rack before you closed
it. Click on the x (Cross) in the Toolbar, if you want to start from scratch again!

41.1  The Component Pool

Open the Component Pool by clicking on Components in the SideKick. It contains all
sound-shaping and modulating components and their Component Presets, ordered by 13
categories. Click on their label to see the available components listed below!

= AMPLIFIERS: Guitar and bass amps
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= CABINETS: Matched cabinets

= DELAY/ECHO: Delays and Echo units

= DISTORTION: Distortion, Overdrive and Fuzz pedals

= DYNAMICS: Compressors, Limiters and Gates

= EQUALIZER: Graphic Equalizers

= FILTERS: Filters and wah-wah pedals

= MODIFIERS: Assignable modifiers for elaborate parameter modulation of other compo-

nents

= MODULATION: Time- and pitch-based modulation effects (Flanger, Octaver, etc.)

= PITCH: Pitched based effects and synthesizers

= REVERBS: Reverbs

= SPECIAL FX: Various specialist effects

= TOOLS: Loop Machine and tools for parallel signal processing
When you select any component by clicking on it, it is highlighted, and a list of all availa-
ble Component Presets is shown below. Learn more about Component Presets in section
14.2, Component Presets.

4.1.2  Setting Up an Amp

The fastest way to start designing sounds with GUITAR RIG 4 is by adding an amp to the
Rack. If you want to quickly create a guitar sound, try the Jump amplifier.

Double-click the amp’s icon in the Component Pool to quickly add it to the (end of the)
Rack. You can also drag it right where you want it to be.

The amplifier and a Matched Cabinet will be inserted into the Rack simultaneously. The
Matched Cabinet is only added automatically if no cabinet is present below the destination
of the amp.

If you play now, you will hear that famous british sound.
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Jdurnp

Fig. 4-2 Jump Amplifier with Matched Cabinet

= To change the cabinet, click on it once, to highlight the component in the Rack. Then
go to the Component Pool, section Amps, and double-click the Cabinet & Mics or the
all-new Control Room module, to replace it.
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Fig. 4-3 Double-click in the Component Pool will replace the Matched Cabinet (highlighed) in the Rack

= All the knobs and switches you see are effectively controlling the amp’s sound. Click-
ing with the mouse flips the switches, clicking and dragging the mouse up and down
(while holding the mouse button down) turns the knobs.

= |f you want to check out some amp settings recommended by our sound designers, try
Component Presets to configure the Hot Plex. Click on the Component Preset display
to jump to the Component Pool.

Fig. 4-4 Component Presets

= The Hot Plex is automatically selected in the Component Pool. Double-click one of
the Component Presets listed below to load it.

4.1.3  Basics for Rack Building

Now you can tweak the amp yourself, add distortion modules, modulating effects or try out
whatever you please! The audio signal runs through the chain of rack modules from top to
bottom, except if you are using special tools that create parallel processing paths, like the
Split. See the Components Reference for details on these tools.
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Rack Usage
= You can add components to the Rack by dragging them from the Component Pool and

dropping them into any position you want. You can also add the component pre-con-
figured to produce a particular sound, by dragging a Component Preset into the Rack
(see section 14.2, Component Presets).

Clicking on any component in the Rack selects it, which is indicated by an orange frame

surrounding it. At the same time, you jump to the according page and item in the Compo-

nent Pool. Thus, while building up your rack, you are always shown the most probable al-

ternatives and the correct list of Component Presets for the selected component.

While a component is highlighted, double-clicking on any item of the Component Pool or

any Component Preset replaces the selected component. This is called hot swapping and

allows for quickly trying out alternatives.

If no component is highlighted, double-clicking on any item of the Component Pool or any

Component Preset adds the component to the end of the Rack. It is then immediately se-

lected and ready for hot swapping with another component.

Hot swapping is also possible when dragging a component or Component Preset into the

Rack: Just drop it directly onto the component you want to replace, which is indicated by

a solid orange rectangle highlighting the destination.

= |f you don’t want to replace another component when using Drag & Drop, make sure

you drop it beneath the other components, which is indicated by an orange line in-
stead of the rectangle.
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Fig. 4-5 Drag and drop: The yellow line indicates where the component will be placed after releasing the mouse button

= Rack Tools (Tuner etc.) have a fixed position and cannot be moved or deleted, but
they can be hidden using the Toolbar.

= You can remove Components from the rack by highlighting them and pressing DEL
(Win) / CMD+BACKSPACE (Mac), or by dragging and dropping them anywhere outside
of the rack. Another option is to choose Delete selected from the context menu, after
right-clicking the component.

The Rack Module Column
All modules in the rack feature a small column on the right:

Fig. 4-6 Rack Module Column

= The 0n/0ff button allows for true bypassing of the module—no CPU power is con-
sumed when it is turned off.
» The—(Minus) button minimizes the module’s display
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= The triangular arrow toggles its expert panel, if available.

4.2  Component Presets

GUITAR RIG 4 comes with plenty of factory presets for components, providing a time-sav-
ing alternative to dialing in classic sounds for each component by hand.

4.2.1 Basics

A Component Preset contains all settings for one single component. After selecting an

item of the Component Pool, a list of all available Component Presets is displayed below
in the SideKick.
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Fig. 4-7 The Component Pool, showing the Amplifiers section

The entries of this list behave just like components, but all their settings are already ad-
justed to create one particular sound. To add a component readily configured, you can
double-click or even drag and drop a Component Preset anywhere into the Rack.
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Component Presets and the Rack

Each rack module displays the name of its current Component Preset in a small box on its
left hand side, the Component Preset Display. It is also a direct link between Rack and
Component Presets, swiftly taking you to the according list when you click on it.

| Sledge Hamvmer |

1

Fig. 4-8 Component Preset selection

Double-clicking the Component Preset in the Component Pool has the same effect as dou-
ble-clicking a basic component, depending on the state of the Rack:
= |f no rack module is highlighted, the component will be added to the end of the rack
with the stored settings.
= |f a different component is highlighted, it will be replaced with the new, pre-config-
ured component.
= |f the same component is highlighted in the rack, its settings will be updated with the
Component Preset. This is useful if you quickly want to check out different settings of
a component in the context of your current rack.

Saving Component Presets

Once you have found a good setting for components you use regularly, you will want to

save your own Component Preset. This is easy:

1. Just click on the triangular arrow right of the Component Preset display and select
Save As from the context menu.
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2. This will create a new entry in the according list of Component Presets. Type in a
name, hit ENTER, and you are done!
= To save any changes to the preset currently displayed, select Save from the same con-
text menu.

Deman Default
# = Presetname Rating

001 INIT

002 Boost Lite

E f disk
004 rooster S

Fig. 4-9 Delecting or renaming a Component Preset

= To delete or rename a Component Preset, right-click on its name in the list and
choose from the context menu accordingly.
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4.2.2 Advanced Usage

Sorting and Rating

By clicking on the column headers of the list of Component Presets, you can sort it by List
Number (#), Name, and Rating. Save a quality rating with each preset by clicking on one
of the 5 dots right beside its name. This can always be changed later.

Component Preset Banks

As soon as you've collected a dozen of your own Component Presets, you might welcome a
possibility to organize them, e.g. by setting them apart from the factory presets in a list of
their own. This is where Component Preset Banks can help you.

Each Component Preset is already part of a bank, indicated by the headline between the
Component Pool and the Component Preset List. The right box (equipped with an arrow)
displays the name of the Component Preset Bank shown below. If you click on it, a context
menu appears, giving you the options Add Bank, Delete Bank and Rename Bank.

Deman Default
Default

Add Bank
Delete Bank

Presetnarme

INIT

Rename Bank -

Raw Booster

rooster

Fig. 4-10 Adding, Deleting, and Renaming Component Preset Banks

If multiple banks are present, you can select one from this context menu by clicking on its
name.
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9 The Rack Tools

The following sections will introduce you to the Rack Tools of GUITAR RIG 4: Tapedeck
Pre and Post, Tuner and Metronome. All of them are useful, but the latter is especially im-
portant, as it is the centre of GUITAR RIG’s ability to synchronize.

9.1  Tapedeck Pre

TapeDeck 1 MMay 24 21 1au

we: 0:00.00 A

Fig. 5-1 The Tapedeck Pre Rack Tool

Tapedeck Pre is the tool for playing back and recording audio at the beginning of GUI-
TAR RIG’s signal chain (except when PLAY AT OUTPUT is activated). Thus, the Tapedeck Pre
picks up the dry, unprocessed sound, enabling you to change the sound of your recording
later. Playing a file back in Tapedeck Pre sends it through all modules currently in the
Rack.

Tapedeck Pre is capable of changing your tempo during playback without changing pitch
and vice versa. This is great for learning licks by slowing them down, or changing the tem-
po on backing loops.

5.1.1  Playback

= The easiest way to load sound files into the Tapedeck is to drag and drop them direct-
ly onto the component. To browse through your files, click on the Load button (with an
open folder as symbol).

= The Tapedecks can play WAV, AIFF and MP3 files up to a resolution of 16bit.

= Click on the Play button to start playback from the current position of the Transport slid-
er. Click on the Stop button to stop playback.
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= |f PLAY AT OUTPUT is activated, the sound will not be processed, but directly played in
front of the Tapedeck Post, wich allows for overdubbing (explained below).
= Adjust the Volume fader to set the playback level. If the Limiter LED lights up, reduce
the volume to avoid overload.
You can create a loop to repeat a certain portion of the file over and over:
= |f the Loop button (right to the Stop button) is pressed, playback will be looped.
= The starting and ending points of the loop are defined by the Start and Stop sliders
above the Transport slider, which can be dragged with the mouse.
= Alternatively, you can set these points “on the fly” by pressing the Loop in and Loop out
buttons during playback.
There are some controls providing special playback options which can be very useful for
practising, or when using backing tracks:
= Transpose (TRANSP) transposes pitch from 12 semitones to +12 semitones.
= TUNE allows fine tuning over the range of —50 cents to +50 cents.
= TEMPO will change the playback speed from 50% of the original tempo to 150% of the
original tempo.

5.1.2  Recording
= |f no other file is loaded, click on the Record button to activate it—pressing the Play
button now will start recording.
= To initialize a new file to be recorded, click on the New button in the lower left. This
will automatically activate the Record button.
= Click on the Play button and begin recording.
= To save a file after recording, click on the Disk button. Navigate to the folder where
you want to save the file. Name the file, and click on the Save button (with a disc sym-

bol).
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9.2  Tapedeck Post

TAPEDECK TapeDeck 2 May 24 21-14-4E wau

=e: 0:00.00

POST

Fig. 5-2 The Tapedeck Post Rack Tool

Tapedeck Post is the tool for playing back and recording audio at the end of GUITAR RIG's
signal chain. Recording your guitar will pick up the processed sound, just as you hear it at
the output. Use Tapedeck Post if you want to record your guitar part with the actual
sound, e.g. for using it "outside of” GUITAR RIG 4. Files you play back will not be proc-
essed, which makes Tapedeck Post ideal for playing drumloops and your own backing
tracks.

Its controls are similar to Tapedeck Pre, except that it has no Transpose (TRANSP), TUNE or
TEMPO controls, nor can you choose between playing at Input or at Output.

9.2.1  Interaction with Tapedeck Pre

Tapedeck Post is linked with Tapedeck Pre to allow for synchronization and easy transfer-
ral of recordings.
= When SYNC DECKS is turned on, the Tapedeck Post starts and stops simultaneously with
the Tapedeck Pre. This is useful when processing samples with GUITAR RIG, as their
timing is kept intact.
= You can easily transfer a recording from Tapedeck Post to Tapedeck Pre by clicking
on the TRANSFER button.

5.2.2  Recording Overdubs

1. As Tapedeck Pre can play its file at the end of the signal chain, but before Tapedeck
Post, you can easily record sketches on multiple tracks using overdubbing. Make sure
both tapedecks are visible by clicking on the buttons in the Toolbar.
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2. Record a track in Tapedeck Post, as explained above. Send it to Tapedeck Pre by
clicking on the TRANSFER button. Alternatively, load a file in Tapedeck Pre which you want
to overdub.

3. Select PLAY AT OUTPUT on Tapedeck Pre.
4. Turn on SYNC DECKS on Tapedeck Post.
5. On Tapedeck Post, click on the New button to create an empty track. Click the Play

button to record your second track as an overdub.
6. If you want to overdub again, click on the TRANSFER button and repeat the described

procedure.

7. After overdubbing as many takes as you want, you can save your work as described
above.

9.3  Tuner

m TUNER mute ]

REFERENMCE PITCH CENTS TUMNE TUME FORK

. I @ °
425Hz A55Hz -7 +7

— . - - - e el

Fig. 5-3 The Tuner Rack Tool

Get in tune quickly and accurately! Besides simple and precise tuning, the Tuner offers
presets for common tunings in a dropdown menu on its left hand side: Chromatic, Bass,
Open D/ E/G/A, and DADGAD tuning.

= The CENT / STROBE buttons switch between two tuning modes:

» |n CENT mode, a small indicator shows whether the pitch is sharp (right of the meter’s
center point) or flat (left of the meter’s center point). The number left of the display
indicates the number of the string being tuned. When a string is in tune, the indicator
sits in the middle of the meter and turns blue.

Tuner
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= In STROBE mode, a series of lights moves to the right when the string is sharp, and to
the left when the string is flat. The faster they move, the more out of tune the string.
When the lights stop moving, the string is in tune.
The MUTE button does what it says and is especially convenient when using the tuner live
and not wanting to disturb the audience or your fellow band members.
Click on the Arrow button to show the tuners expert panel:
= REFERENCE PITCH sets the tuning reference, from A=425Hz to A=455Hz. The exact
pitch is shown while you drag the knob.
= CENTS shows the deviation from ideal tuning in cents.
= TUNE transposes the tuning range. If you e.g. want to tune all strings a semitone lower,
set drop tune to -1.
= TUNE FORK produces a reference tone. To select its pitch, click on the note field to the
right and drag up or down, or click on the Arrow buttons.

9.4  Metronome and Synchronization

!l METRONOME et

120.00K

Fig. 5-4 The Metronome Rack Tool

The Metronome is not only for keeping yourself in time, but it also serves as the clock for
all synchronized rack modules, such as modulation and delay effects.
If you are not in Sync mode (see below), you can set the tempo yourself several ways:
= Dial in any tempo between 20 and 400 beats per minute by clicking on the BPM dis-
play and dragging up or down, clicking on the arrows, or by double-clicking and enter-
ing the number directly.
= Click on the TAP button repeatedly. The Metronome will determine your average speed
and set the BPM control accordingly. It is very convenient to assign this button to a
foot controller (see section 16.2, Assigning Functions to the Rig Kontrol to see how)
to actually tap the tempo.
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= You can choose different time signatures using the dropdown menu besides the Signat.
display. The time signature determines the relation between downbeats and offbeats.
= |f the MUTE button is not pressed, this is reflected in the succession of sounds #1 and
#2, as defined in the boxes below:
= #1 is the sound played on downbeats and strong beat divisions.
= #2 is the sound played on weak beats.
You can change both sounds to any .WAYV file you want by clicking on the respective Load
button
The sync setting defines if the Metronome obtains its tempo setting from any other source.
The three available sync settings are:
= ext: When in plug-in mode, the Metronome is synchronized to the host’s tempo, to the
external MIDI clock when in stand-alone mode. All controls for setting the tempo are
disabled.
= sound: The current tempo is stored with the Rack content when you save a preset. In
this setting, the Metronome loads the tempo information when you load a preset. This
is useful for preparing presets with synchronized effects e.g. for a live show.
= free: This effectively turns host and preset synchronization off. The Metronome can
run freely at the tempo you set, independent of the preset loaded or the host’s tempo.
It is still giving the clock for all synchronized effects in the rack, and the current tem-
po is still saved with the preset!
*= The MUTE button and the VOLUME knob serve to adjust the volume of the Metronome
sound or to mute it.

5.5  Preset Volume

Fig. 5-5 The Preset Volume Rack Tool
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The sound of many of GUITAR RIG’s components is highly sensitive to the level of their
input signal and their volume setting—just think of an amp being overdriven. This is com-
monly used for the sake of sound design, resulting in volume differences between pre-
sets.Thus, you might want to adjust the overall volume of your Rack to achieve the same
Output Level for different presets. This is exactly what the Preset Volume does: Simply ad-
just the big volume fader after you have found the sound you were looking for—its position
is automatically saved with your preset.
= Use the LEARN button to automatically set the optimum Preset Volume: After clicking
on it, just play loudly for a little while until the volume is automatically adjusted.
= The PRE Button allows you to hear Dry / Wet mixing before audio goes into the rack. In
default mode mixing is done after the rack and before the Master FX.
= Use the DRY slider to control the volume level of the dry signal.
= Use the MIX crossfader to switch between the Dry signal and the Wet (effected) signal.
= Use the WET slider to control the volume level of the wet signal.
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5.6 Master FX
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Fig. 5-6 The Master FX Rack Tool with Delay and Reverb preset.

Whether you want to let a long delay ring over your change of presets, add a global EQ to
all of your presets—for example when using them live—or just stick to your FX chain while
changing amp presets: Master FX is what you need.
The Master FX extends the Rack by a section at the end, which holds components process-
ing the sound after it went through the “core” Rack. The main difference is that the con-
tent of this section remains unchanged when you load another Rack Preset, enabling vari-
ous usages as indicated above.
Using this section should feel very natural if you look at it as a Rack inside the Rack:

= Add components from the Components Pool or the Rack with drag and drop. The or-

ange line indicating the destination must be below the Master FX header.

= Delete, move or quickly replace components as you're used to.

= Use Component Presets to configure your Master FX chain as you please.

= Click on the x (cross) to empty the whole Master FX section.
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= Click on the arrow to minimize the Master FX section.

Master FX Presets

You can store any chain of components in a Component Preset for the Master FX. This
works just the same as with any regular component: Click on the arrow of the black Com-
ponent

Preset Display to open the dropdown menu, and select Save As. Master FX Presets are
stored in the Tools section of the Component Pool. Note that loading them doesn't require
selecting the Master FX first, as this is the only possible destination for these presets. Just
as the other Rack Tools, the Master FX can’t be selected or highlighted.
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b The Rig Kontrol

This section is about the integration of GUITAR RIG with the Rig Kontrol pedalboard—if
this does not concern you, you can just skip it. To learn how to assign your MIDI controller
to the Virtual Rig Kontrol, refer to section 18.1.3, Linking External MIDI Controllers to the
Virtual Rig Kontrol

The Rig Kontrol is a fully integrated hardware solution for using and controlling GUI-
TAR RIG 4. Nine freely assignable knobs and an expression pedal are at your disposal
right after connecting it. Note that you can use the Rig Kontrol to control GUITAR RIG 4,
even if you do not use it as your audio interface. For detailed information about the hard-
ware and how to use the integrated audio interface, refer to the Hardware Reference.
Before you continue, make sure that your Rig Kontrol is connected via USB 2.0 and acti-
vate the Virtual Rig Kontrol by clicking on its button in the Toolbar. On the Virtual Rig
Kontrol, each button is headed with an LED indicating its status (on/off). The LED bar left
of the foot pedal shows the degree to which it is pressed down. The Virtual Rig Kontrol
provides an expert panel to manage and configure assignments, e.g. to set the range of
each controlled parameter.

6.1  Activating the Rig Kontrol

The RIG KONTROL is automatically activated in GUITAR RIG the moment it is plugged in.
When running multiple instances of GUITAR RIG (for example as a plug-in), the last one
launched is controlled by the RIG KONTROL by default.
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Fig. 6-1 The Virtual Rig Kontrol

To change its focus to the instance you want to control, bring up the Virtual Rig Kontrol by
clicking on its button in the Toolbar or by pressing F3. By clicking on the Active LED, the
RIG KONTROL is activated in this particular instance.

6.2  Assigning Functions to the Rig Kontrol

The labels below the buttons and left of the foot pedal show which function is currently
assigned to them. The buttons of the RIG KONTROL are best suited for controlling Power /
Input Mute buttons and the likes, whereas the pedal is perfect for continuous parameters
like the wah-wah slider or volume.

Drag and Drop

Assigning functions by yourself is easy with drag and drop:

1. Click on one of the labels and drag it anywhere into the Rack. The knob or switch you
drop it onto is instantly assigned to the button of the Rig Kontrol whose label you
dragged.

2. |If you operate a knob or the pedal of the (physical) RIG KONTROL, both the Virtual
Rig Kontrol and the assigned function will react to it.
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Fig. 6-2 The label of Switch 1 is dragged onto the Volume | knob of the Plex.

While dragging, the mouse pointer gives you feedback as to where you can create an as-
signment by showing a small arrow. A No Entry sign is shown at areas where dropping the
item is not possible.

Context Menu

Alternatively, you can use the context menu to browse through all assighable functions:
just right-click on the label of the switch you want to assign to call it up.
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Fig. 6-3 The context menu also offers to remove all of the assignments of a particular control with one click on Clear All.

Most importantly, you can choose to Lock this control’s current assignments, protecting
them from being altered when changing Rack Presets - until you unlock them, again using
the context menu. The global status of any controller is indicated by the padlock symbol.

6.3  Configuring Assignments

The RIG KONTROL's assignments can be managed in the expert panel of the Virtual Rig
Kontrol. Click on the arrow button to reveal it, then click on a label or knob on the Virtual
Rig Kontrol to select it. The functions assigned to this particular control are now shown in
the expert panel.
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Fig. 6-4 Virtual Rig Kontrol Expert Panel

Here is what the expert panel can do for you:

= Assigning functions by dragging and dropping the white label in the upper-left corner.

= To change the display name for the selected control, change the text in the black
field on top of the expert panel. This is—regardless of the text in the white label—
what is shown on the Virtual Rig Kontrol.

= There are two pages with 4 assignment slots each. If you are using more than 4 as-
signments, click on the button labeled 5-8 to show them.

= To temporarily deactivate an assignment, click on the tickmark on its left-hand side.
Click again to reactivate it.

» To delete an assignment, click on the x (Cross) on its right-hand side. To delete all
assignments for a particular controller, right-click on its label and select Clear All.

Mapped Range of Parameters

There is a horizontal line representing the value range of each assignment. To adjust the
way the controller’s input values are mapped to the assigned parameter, you can click and
drag the Brackets left and right of the line.
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= The left bracket defines the value mapped to the controller at zero, the right one the
value mapped to the controller fully turned up.

= As switches always send these extreme on/off values, the brackets can be used to de-
fine which actual knob positions they trigger. Thus, you can configure a button to
switch between 12 o’clock and full gain, and so on.

= Because you can drag the brackets across to the other end, you can even invert the
mapping, so that, e.g. the assigned knob will be turned down when you push the ped-
al, instead of down. This is useful if you want to assign two different value changes to
one control, e.g. increasing gain while turning master volume down.

6.4  Assigning Functions to External Controllers

You can connect external footswitches or pedals to your RIG KONTROL's analogue control-
ler inputs and easily assign them using the Virtual Rig Kontrol. Please make sure the in-
puts are correctly configured in the Preferences pane (see section 18.2, Preferences) first.
Activate the expert panel of the Virtual Rig Kontrol by clicking on the arrow button. In the
upper right corner there are two labels representing your analogue controllers, and they be-
have exactly like the Rig Kontrol labels. The assignment of functions works the same as
with the internal controls of the RIG KONTROL:

1. Click on the arrow button on the Virtual Rig Kontrol to show its expert panel.

2. Drag the Pedal 1 or Pedal 2 button onto any function in the Rack.

III If the external footswitch you are using is “on” only while pressed (instead of switching be-
tween “on” and “off"”), activate Toggle Mode in the context menu of the according input.
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1 Using Guitar Rig in a Host

GUITAR RIG 4 works within all digital audio workstations (DAWs) that support the VST,
RTAS or AU plug-in interface. The plug-in is automatically installed.

1.1 Basics

After installation, you can instantly use GUITAR RIG 4 in your host just like any other
plug-in. The plug-in and the stand-alone version of GUITAR RIG 4 share the same presets
and settings—any changes you make in one will naturally affect the other!

1.1.1  Audio and MIDI Setup

In plug-in mode, the audio interface is controlled by the host application, so the Audio
and MIDI settings of GUITAR RIG are not effective. Please consult the documentation of
your DAW on how to set up audio and MIDI. Remember to avoid zero-latency and direct
monitoring options, as you won't hear your guitar processed by GUITAR RIG 4 if these are
turned on.

1.1.2  Plug-In Location

During the installation of GUITAR RIG 4 on a Windows computer, you need to specify the
folder where your DAW looks for VST plug-ins. This is where the plug-in file “Guitar Rig
4.dll" has been copied—you can move it anytime, in case you changed your plug-in folder
or made a mistake. It might be necessary to re-scan the plug-in folder in your DAW before
GUITAR RIG 4 appears in the list.

On a Mac, plug-ins are centrally stored in the Library under Audio/Plug-Ins.

1.1.3  Setting Up a Guitar or Bass Track

To setup a track to be processed by GUITAR RIG 4, just create an audio track and insert
GUITAR RIG 4 as an effect. The audio track will hold the bare, unprocessed signal and
your sound will be routed through GUITAR RIG before reaching the output stage of your
DAW. Thus, you can easily tweak the sound of your guitar or bass tracks after recording
(re-amping) and even automate the parameters of your sound as a part of your arrange-
ment (see section 14.2, Component Presets).
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Attention: Although some programs allow you to plug in GUITAR RIG 4 as a MIDI instru-
ment (because it works both with audio and MIDI), you should use it as a signal process-
ing / effects insert.

1.1.4  Synchronization

If you want GUITAR RIG 4 to be in time with your host, remember to turn on Ext mode in
the Metronome (see section 15.4, Metronome and Synchronization). This will turn off the
speed setting of GUITAR RIG and use the host’s tempo as a master. This affects all
synchronized effects and the modifiers, as well as the Metronome itself.

1.1.5  Total Recall

When using GUITAR RIG 4 within a DAW and you save your project, it will save whatever
is the current state of GUITAR RIG 4. So, if you using a modified preset (as compared to
how it is stored), don’t worry—when you next load the project, the rack will be recalled ex-
actly as you left it.

1.2  Automating Parameters

This section is intended to give a mere introduction to automation and the characteristics
of GUITAR RIG 4 in this regard. As this is a sequencer subject, please refer to your DAW’s
documentation to learn how it works with your particular software.

Automation in a sequencer means recording parameter changes: The movements of your
wah wah pedal, or operating the power switch of the fuzz right before the solo! This can be
done immediately while you play, e.g. with a foot pedal, or in a separate step afterwards.
Automating parameters is super easy when you use GUITAR RIG 4 as a plug-in! Whether
you set up your controller hardware in GUITAR RIG or in your host, or if you want to use
your mouse to control parameters: Any way to move the knobs in GUITAR RIG is a way to
record automation!
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1.2.1  The Automation List

Please refer to your DAW’s documentation to learn how to show the Automation List for the
track where the GUITAR RIG 4 plug-in is inserted. All parameters of components that are
currently in your Rack are automatically present in the Automation List, so they can be ad-
dressed by track automation in your sequencer. Check the context menu of any knob to
see its current automation ID!
= The automation list offers 512 slots, divided into three areas of application:
= The first 256 slots are reserved for component parameters of the main rack.
= Slots 257-383 are statically assigned and reserved to Rack Tools and Framework Pa-
rameters (such as Preset Volume).
= Slots beyond 384 are dynamically assigned to component parameters used in the
Master FX section.
Deleting a module from the rack results in clearing of the slots it had occupied before.
When you add a new one, it tries to fit its parameters into the empty spaces within the
current Automation List. Only if this is not possible, entries will be appended at the end of
the list.

Enabling Automation for Rack Tools

The Rack Tools (Metronome, Tapedecks, etc.) are by default set to automation with static
automation IDs. However, there is an option to switch any Rack Tool back to dynamically
assigned automation IDs, in order to maintain backwards compatibility.

To switch between the automation modes:

Right-click a Rack Tool and select Enable Static Automation IDs or Disable Static Automa-
tion IDs (whichever mode you’d like to activate).

Rebuilding the Automation List

After you have added and removed numerous components, your Automation List can be a
bit of a mess. If you want to fill up all the empty spaces, right click any component of your
Rack (while in plug-in mode) and select Rebuild Automation List from the context menu.
Mind that all your previously recorded automation might be assigned to a wrong compo-
nent now, as a result of their changing positions in the Automation List.
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Automating Parameters in Apple Logic Pro

This example explains how to work with Apple Logic Pro, but all other DAW software oper-
ates in a similar fashion. Please refer to the documentation for your DAW for more infor-
mation on the specifics of your host.

1.

2.
3.
4.

In the View menu, turn on track automation for the selected track, so you can see
what you are doing.

Change the track to Latch or Touch mode

Start playback.

Move the desired control(s) of GUITAR RIG using the RIG KONTROL, any MIDI con-
troller or your mouse.

The automation will be recorded automatically as you play back the track. Of course, you
can also use the pencil tool to draw automation by hand!
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8 Options

The Options tab provides access to two areas: Controller assignments and general Preferences
for configuring the application.

8.1 Controller

Controller 1

Learn CHOnEa= Menu

Controller 2

Learn <ROne> Menu

Controller 3

Learn <hOne=> Menu

Add Controller Delete Controller

Fig. 8.1 The dialog for managing controller assignments

This page lets you set up and manage your external MIDI controller assignments. Before
you continue, please make sure that your MIDI interface is activated in the Audio and
MIDI settings (see section 110, Audio and MIDI Settings). Also check if the correct MIDI
channel is selected on the Preferences tab (see section 18.2, Preferences). Note that GUI-
TAR RIG 4 reacts to MIDI Program Change messages regardless of assignments: They
switch presets within the current Preset List.

Controller Assignment the Easy Way

The quickest way to control any knob with a MIDI device is provided by its context menu:
1. Right-click on the knob or fader you want to control.
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2. Select Learn.

3. Operate the external controller. It is instantly linked to the parameter.

A message will appear informing you that a new controller has been added—GUITAR RIG
makes no difference between keyboard shortcuts and MIDI messages! Note that you can
also clear all assigned controllers using the same context menu.

8.1.1  Setting up External MIDI Controllers

Each of your device’'s controls (knobs, fader, etc.) can be configured via the Controller

list . You only need to do this once, as the Controller list is global for all presets. Make

sure you are on the Controller tab of the Options page in the SideKick. Follow these steps
to add a new MIDI controller:

1. Click on the Add Controller button on the bottom of the SideKick to add a new controller
entry. Rename it by double-clicking on the white headline bar.

2. To link a (physical) device to the controller entry, click on the Learn button and oper-
ate the knob (fader, etc.) you want to link briefly. Its MIDI code will be shown in the
box right of the button and the Learn button will pop out. It is also possible to assign
keyboard shortcuts the same way!

If you want to change the device a controller is linked to, just click Learn again and operate

the desired knob.

Important: If the MIDI footswitch you are using is sending “on” only while it is pressed

(instead of switching between “on” and “off” each time you press it), this will be the be-

havior of the assigned parameter as well. If you want to change it, activate Toggle Mode in

the Menu of the according controller.

Options
Controller
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Deleting Controllers
To delete any entry of the Controller list, first select it by clicking once—it is highlighted
by an orange frame. Then click on the Delete Controller button on the bottom of the SideKick.

8.1.2  Assigning Functions to Controllers

Each controller input can trigger different functions in GUITAR RIG at once. Its assign-

ments are shown below the Controller list entry, each in a separate line.

1. To assign a function of GUITAR RIG to the controller, drag its white headline bar onto
the element (knob, button, fader, etc.) of the Rack that you want to control.

2. While dragging, the mouse pointer gives you feedback as to where you can create an
assignment by showing a small arrow. A No Entry sign is shown where dropping would
make no sense.

3. The function you just assigned is now listed below the according entry in the Controller
list. More assignments can be added the same way.

MNew Control &0

Learn CAONE> Menu -

v Matched Cabinet.Air . ™)

' AC Box.Brilliant Volume — ]

Fig. 8-1 Assigning controllers

Configuring and Deleting Assignments

= To temporarily deactivate an assignment, click on the tickmark on its left-hand side.

= To delete an assignment, click on the x (Cross) on its right-hand side.

= To delete all assignments for a particular controller, click on the Menu button and se-
lect Clear All.

= To adjust the way the controller’'s input values are mapped to the assigned function,
you can click and drag the Brackets left and right of the horizontal line.

= The left Bracket defines the value mapped to the controller at zero (MIDI value 0),
the right one the value mapped to the controller fully turned up (MIDI value 127).

= As switches always send these extreme on/off values, the Brackets can be used to de-
fine which actual knob positions they trigger.
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= As you can drag the brackets across, you can invert the mapping, so that the assigned
knob will be turned up when you turn your controller down.

Assigning Functions via Menu

Drag and drop is not the only way for creating controller assignments, the Menu button of-
fers an alternative, listing all available functions in a menu-like interface. Click on the
Menu button and navigate through the categories and click on any function to create an as-
signment.

Controller Preferences
MNew Control

Learn <HRoOne>

Clear All

Enable Toggle Mode

v

Preset Selection

Audio In
TapeDeck 1
Tuner
Metronome
Citrus

Octaverb
Matched Cabinet
TapeDeck 2
Audio Out

vy vy vy vy VYyYYyYVYTYTYY

Fig. 8-2 The Controller menu

Even if you prefer drag and drop, the menu is necessary to assign functions that are not
controlled by any rack module, e.g. switching presets.
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By default, all assignments are stored on the preset level, so they change as the preset
changes. In most cases, this is the expected behavior, but you may wish to have some
global assignments that are always the same. The most obvious and common case is when
you assign Sound Selection—Previous / Next to a controller to step through the presets.

To make any controller’'s assignments global (overriding assignments on preset level), click
on the according Menu button and select Lock (a padlock symbol appears).

Controller Preferences
Mew Contral 8 &

—_m s -, UHTDEk

Fig. 8-3 Unlocking the controller
Unlock the controller the same way to be able to add or delete assignments.

8.1.3  Linking External MIDI Controllers to the Virtual Rig Kontrol

The Virtual Rig Kontrol is a perfectly integrated component of GUITAR RIG 4, sporting
pre-assigned functions for many presets and a convenient display for all its assignments,
especially in Live view. If your external MIDI controller features a comparable set of con-
trols, it can make sense to map it to the Virtual Rig Kontrol and then use the latter for
assigning functions instead.

Linking its knobs and the pedal to any controller input works exactly the same as with oth-
er functions: Just drag the controller and drop it onto the button of the Virtual Rig Kontrol
you want it to be linked with. All the functions assigned to this particular button will now
be triggered by the linked controller input. Assigning functions to the Virtual Rig Kontrol
works by dragging the box below or beneath each of its controls (containing its name) onto
the desired knob or switch in the rack. See section 16.2, Assigning Functions to the Rig
Kontrol to learn more!

Options
Controller
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8.1.4  Hold Mode for MIDI Controllers and Rig Kontrol

There are generally two ways a switch can behave:
= The more common type switches between the “on” and “off” state each time it is op-
erated.
= The other type is a “momentary” switch. It remains in the “on” state only while it is
operated, i.e. as long as the button is depressed, and returns to “off” as soon as it is
released, which can be very useful when triggering effects.
In Guitar Rig 4, each controller input can be set to work in “Hold Mode” via its context
menu to reflect this difference. Just right-click any label of the Virtual Rig Kontrol, or click
on Menu in any entry of the MIDI Controller list to call it up.

() Browser (» Components (®) Options ¥ 2inthe Street

COM
My Controller Button 1

Learn CC#114 Menu

Lock

Clear All

Disable Hold Mode

Fig. 8-4 Disable Hold Mode for a MIDI Controller
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Fig. 8-5 Enabling Hold Mode for Virtual Rig Kontrol

Hold Mode acts differently depending on the hardware connected:

= Per default, the Rig Kontrol switches toggle “on” and “off” each time they are operat-
ed. Enabling Hold Mode will turn them into momentary switches.

= Most common switches on a MIDI controller should work just as Rig Kontrol switches.
However, if you find them behaving weirdly—i.e. they need to be operated two times
to toggle on or off—you should try the other mode.

= Momentary switches on a MIDI controller will work as such when Hold Mode is ena-
bled. In most cases, turning off Hold Mode will enable them to work in the other
mode as well.

8.2  Preferences

On the Options tab, click on Preferences to call up the control center for configuring GUI-
TAR RIG 4.
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Impart Guitar Rig 3 Content Import
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OFF

PRESET

Rig Kontral Ext Pedals Calibration

Fig. 8-6 The Preferences Menu

It offers the following settings:

= Window Height: Use this control to set the height of the GUITAR RIG 4 window. You can
choose among Small, Medium or Large. The actual dimensions in pixels (given in
brackets) depend on the physical display resolution of your monitor.

= MIDI Channel: Set the channel on which GUITAR RIG listens for incoming MIDI messag-
es. Choose Omni if you want it to listen on all channels.

= MIDI Learn Popup Window: Toggles whether or not the MIDI Learn Window will pop up after
each MIDI assignment you make.

= Show Help Hints: Toggles whether hints appear when the mouse is hovering over control
elements.
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= Scan For New Presets: Updates the preset database. Use if you copied files to the preset
folder manually or created new presets using Kore?2.

= Restore Factory Content: If you accidentally deleted or changed any of the presets that
came with GUITAR RIG 4, you can make a fresh start. Your own presets remain unaf-
fected.

= Import GR3 Content: Select to scan for GUITAR RIG 3 presets and component templates.

= Virtual Rig Kontrol Style: You can adapt the appearance of the Virtual Rig Kontrol, if you
are using the silver Rig Kontrol 2.

= Rig Kontrol 1: Turn on to activate compatibility mode for the blue Rig kontrol 1.

= Rig Kontrol Pedal Parameter Mode: Controls with which value the pedal and its assigned pa-
rameters are initiated when a preset is loaded: The actual current position the pedal
is in (Pedal Mode) or the one stored with the preset (Preset Mode).

= Rig Kontrol Pedal Calibration: If your RIG KONTROL pedal does not behave as intended,
click Reset, and follow the instructions to recalibrate it.

= Rig Kontrol Ext. Pedals Calibration: If the external pedals connected to your RIG KONTROL
do not behave as intended, click Reset, and follow the instructions to recalibrate
them.

= Rig Kontrol 3 Ext. Pedal 1/2 Mode: Use this menu to adjust the Rig Kontrol to different types
of external pedals or footswitches. Please refer to the documentation of your pedal /
footswitch to find out the correct setting. If it doesn’t work, just try out the other set-
ting.

8.2.1 Rig Kontrol 1 Support

The earliest Rig Kontrol can still be used for controlling Guitar Rig 4, with the natural limi-
tation of having only one audio input channel, of course. The second channel transmits
the unit’s control signal and is therefore not available. To activate Rig Kontrol 1 compati-
bility, go to the Options pane in the SideKick and select Preferences.
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Fig. 8-7 Rig Kontrol Options

1. Inthe line labeled Rig Kontrol 1, click on the dropdown menu.

2. Select the channel your Rig Kontrol is sending the control signal on (Left or Right)

The according channel button in the Global Header turns blue to indicate that it is
blocked by the Rig Kontrol 1.

N | L |

Fig. 8-8 Left channel blocked by Rig Kontrol
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9 Menu Bar

GUITAR RIG 4 is designed in a way that—once set up—you will hardly ever need to use
the Menu bar. Most of its functions are easier to access another way, as explained above.
However, it may be necessary to change the "Audio and MIDI settings..." in standalone
mode, and also all the GUITAR RIG 4 documentation is conveniently linked in the Help
menu.

9.1  File

New Sound
Creates an empty new preset. Just enter a name, press Save and fill the Rack with your
components of choice!

Save Sound
Has the same effect as clicking on Save in the Preset Browser. Saves changes to the cur-
rently loaded preset.

Save Sound As...
Has the same effect as clicking on Save as... in the Preset Browser. Saves the current rack
as a new preset.

Import

Allows to import GUITAR RIG 3 and 4 presets into the Preset Browser. This option lets you
browse for preset files with the extension .ksd. An easier way to import is to just drag and
drop the files into the Preset Browser. Note that, depending on the components and set-
tings used, GUITAR RIG 3 presets might sound a bit different—to the better, we hope!

Audio and MIDI Settings...
To configure the audio and MIDI system of GUITAR RIG 4 for standalone use. See section
110, Audio and MIDI Settings for details.

Menu Bar
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Exit

Quits the application.
9.2  Edit

Undo

Allows to take back the last operations, including destructive errors like clearing the whole
rack.

Redo
Repeats the last undone step.

Cut/ Copy / Paste / Delete / Select All

Performs the standard edit operations in the current context: Copy and paste rack mod-
ules, select all or delete entries from the Preset List, and so on. The action performed de-
pends on the currently selected area of the user interface, i.e. where you last clicked.

9.3 View

Hide/Show Hints
Has the same effect as the according option in Preferences. Disables or enables the helpful
hints shown when the mouse is hovering over control elements.

Full Screen
Activates full screen mode, giving you the maximum possible resolution - extremely useful
in Live view. Press ESC or F4 to return to normal mode.

Hide/Show SideKick

Hides or shows the left area of the GUITAR RIG 4 user interface, where Preset Browser,
Components Browser and Options are displayed.
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Hide/Show LiveView
Has the same effect as clicking on the Live button. Activates or deactivates Live view.

Hide/Show Rig Kontrol
Has the same effect as clicking on the Virtual Rig Kontrol button. Hides or shows the Vir-
tual Rig Kontrol.

94  Help

Launch Service Center...
Starts the Native Instruments Service Center—for activating the application and download-
ing updates. Read the Setup Guide for more information!

Activate GUITAR RIG 4...
Starts the Native Instruments Service Center, directly taking you to the Activation tab.

Open Manual...
For access to all available manuals, navigate to your language.

Visit GUITAR RIG 4 on the Web...
Your permanent bookmark to the GUITAR RIG 4 website, where you find product-related
resources, news and entertaining extras!

Visit the Knowledge Base...
Another extremely useful bookmark leads to the Knowledge Base, your primary source for
troubleshooting and sharing technical experiences with GUITAR RIG 4.

About GUITAR RIG 4

Brings up the About-Screen, giving information about the software version, your registra-
tion number and the creators of GUITAR RIG 4.
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10  Audio and MIDI Settings

This section explains how to configure GUITAR RIG’s Audio and MIDI Settings.

10.1  Audio

’ Driver  CoreAudio -
Device  RigKontrol3 (2 In, 2 Out) -
Status | Running |
Sample Rate (44100 -]
Latency 64 Samples [[11l] ]
Input» 5.8 ms | Processing » 1.5ms | Output» 58 ms | Overall » 13.1 ms

|:ﬂl(lan:el] |: ® 0K J

Driver
Choose the correct type of driver for your audio interface. Using ASIO (Windows) / CoreAu-

dio (MacOS) is strongly recommended.
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Device
Select your audio device from the list. If it doesn’t appear, check if it is connected and its
drivers are properly installed.

Status

Shows the current status of the selected audio interface, which should be Running. If it
says Stopped, please consult the documentation of your audio interface. Check if it is con-
nected and if its drivers are properly installed.

Sample Rate
Choose the desired sample rate for audio processing, the standard is 44100 Hz. Higher
sample rates may result in higher quality, but they definitely consume more CPU power.

Latency
Latency is the time that passes between the moment you hit a note and the moment you
hear it. It is caused by several stages of data transfer and audio processing, which all con-
sume a small amount of time. The latency allowed for processing can be adjusted within a
certain range, but the lower you go, the higher the probability of processing errors gets. All
depends on your processing power and the quality of your audio drivers! It is strongly rec-
ommended to consult the documentation of your audio interface to learn more.
= For a Windows Computer, click on the ASIO Config button to change the latency. Your
audio driver’s setup window will be called up.
= On a Mac, latency is set directly in the Audio and MIDI settings. Use the Latency slid-
er to try out how low you can go. Play while you are moving it, and watch out for
crackles, pops and dropouts. If they occur, your latency is set too low.
The latency value is given in samples, its time value can be calculated easily: Divide the
number of samples by the sample rate (samples/s) and you get the processing latency in
seconds. To spare you the trouble, the three major stages of latency are calculated in the
Audio and MIDI settings... window automatically, as well as the resulting overall latency in milli-
seconds. Note that this value might be higher than what you're used to, because often,
you are only given the internal buffer size in ms, instead of the real overall latency.

Audio
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Audio

Routing

If you want to invert the Input or Output channels or set up a special routing for multi-
channel setups, this is the place to go. The left column shows the available channels of
your audio interface. The entries in the right column are actually menus. By clicking on
them, you can assign the left and right channels of GUITAR RIG 4 to any of your audio
interfaces channels. This is done separately for Input and Output. Be careful, as a miscon-
figuration of the Routing table may lead to not hearing any output anymore.

MIDI

The left column shows all available MIDI devices , sorted by Input and Output. The entries
in the right column are actually menus. By clicking on them, you can turn them on or off.
Mind that any devices you want to use to control GUITAR RIG 4 have to be activated
(turned On) under Input.
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11 Keyboard Shortcuts

Find below a list of keyboard shortcuts for use with GUITAR RIG. These provide shortcuts
from system basics to switching between different views. With keyboard shortcuts, you can
quickly perform tasks on your computer by pressing keys on your keyboard instead of using
a mouse.

If you're working on a portable computer, you must press the Fn key before pressing the other
keys of a shortcut; for example, press Fn-Control-F1.

Type Command Windows Mac

File New Preset Ctrl+N Cmd+N

File Save Preset Ctrl+S Cmd+S

File Save As Preset Ctrl+Shift+S Cmd+Shift+S
File Quit Alt+F4 Cmd+Q

Edit Undo Ctrl+Z Cmd+Z

Edit Redo Ctrl+Y Cmd+Shift+Z
Edit Cut Ctrl+X Cmd+X

Edit Copy Ctrl+C Cmd+C

Edit Paste Ctrl+V Cmd+V

Edit Delete Del Delete

Edit Select All Ctrl+A Cmd+A

View Hide/Show Hints Ctrl+l Cmd+l

View Full Screen F4 F4

View Hide/Show RigKontrol F3 F3

View Hide/Show SideKick F2 F2

View Hide/Show Live View F1 Fl
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Amps
adding [37]
Knobs [34]
Switches [34]
AU [57]
Audio and MIDI Settings [/4]
MIDI [76]
Audio Device [/5]
Browser [20]
Creating tags [25]
Finding presets [21]
Loading presets [27]
Preset Attributes [20]
Preset Info [28]
Preset List [20]
Saving presets [23]
Sub-tags [25]
Tagging presets [26]
Bypass [10]
Component Pool [31]
Component Presets [3/]
Banks [41]
Display [39]
List [37]
Loading [38]
Saving [39]
CPU load [10]
Driver Settings [/4]
Gate [9]
Global Header [9]

High Quality mode [10]

Input meter [9]

Input routing [9]

Keyhoard Shortcuts [/7/]

Latency [/5]

Limiter [10]

Live view [11]

Master FX [49]

Menu bar [/1]

Metronome [46]

MIDI controllers [61]
Assigning functions [63]
Configuration [62]
Configuring assignments [63]
Global assignments [65]
Menu [64]

Options [61]

Output meter [9]

Overdubbing [44]

Playing back audio [4?]

Plug-In [57]

Automation [58]
Location [57]

Preferences [67]

Preset List
Sorting [20]

Preset Volume [48]

Presets
Component Presets [18]
Rack Presets [18]

Rack [30]

Index
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drag and drop [35]
Rack Module Column [36]
Rack Tools [4?7]
Rating [20]
Recording audio [43]
Rig Kontrol [51]
Activation [51]
Assigning functions [52]
Assignment range [55]
Configuring assignments [54]
External controllers [56]
Global assignments [54]
Hold Mode [66]
Linking Controllers [65]

Index

Routing [76]

RTAS [57]

Safety Considerations [7/]
Sample Rate [75]
SideKick [15]

Signal flow [34]
Synchronization [47]
System performance [10]
Tapedeck Post [44]
Tapedeck Pre [4?7]
Toolbar [13]

Tuner [45]

User interface [8]

VST [57]
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